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Mill/Turn
Mill/Turn capabilities are available when both theMill and Turningmodules of the software are
accessible. Mill/Turn allows you to createmilling and turning operationswithin the same part. All
milling and turning functions are available for Mill/Turn parts. Additionalmodules are available that
increase the capabilities of Mill/Turn, most importantly the Polar & Cylindrical Milling option, which
provides the ability to wrap any shape or toolpath around the C axis using rotary axis interpolation.

TheMill/Turn functionality of the software provides capabilities for programming single-spindle,
single-turret turningmachines that have the capability of driving live tooling. The turret positions can
drive live tools such as endmills and drills that can be oriented along the Z axis, toward the chuck
(facemachining), or along the X axis, toward the turret (OD machining). In order to performmilling
operations, the spindlemust be changed from its normal function of spinning the part into a third
programmable axis, usually designated as the C axis. TheMill/Turn functionality allows users to
position the part by specifying angular rotations of the C axis.

Note: This symbol on the right signifiesMill/Turn functions that are enhanced
by the Advanced CSmodule.

Interface
In order to use theMill/Turn functions the Level 2 interfacemust be activated from the File >
Preferences > Interface dialog.

Machining Palette
When aMill/TurnMDD is selected, theMachining palette contains bothMill and Turning processes.
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1. Mill processes
2. Turning processes

The Process List can hold amixture of Mill and Turning processes.

Coordinate Systems
If you have the Advanced CS option, it is recommended that you cover thematerial in the Advanced
CS guide. The following is the limited interface information on coordinate systems, and is intended
as information for users who do not have the Advanced CS option installed.

What is a Coordinate System?
• A Coordinate System is a plane in space with an origin and three axes.

The origin is the point at which the axes intersect and serves as a zero reference point. The
three axes are the horizontal, vertical and depth axes. In the standard lathe ZX plane, the Z is
horizontal, the X is vertical, and the Y is the depth.

• A Coordinate System is NOT aWorkgroup.
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Coordinate systems are independent of workgroups. Multiple coordinate systems can be used
in one workgroup and the same coordinate system can be used inmultiple workgroups.

• A coordinate system is an attribute of geometry elements (points, lines, circles, etc.).

Geometry can be defined with a CS as the foundation but it is not dependent upon it. Geometry
can remain while its CS foundation can be deleted (User CS via Advanced CS). However the
geometrymust be changed to use another CS as the foundation for its attributes.

HVD vs. XYZ
These letters are reference labels for the axes of a coordinate system. Every coordinate system
must have an HV and D Axis. X, Y and Z are the labels used for the horizontal, vertical and depth
axes of the standard XY plane. The labels X, Y and Z will be used as the axis labels if any or all of
the axes align with the standard XY plane. The labels used in the dialogmay vary when the current
coordinate system alignswith one of the primary planes. The labels X, Y and Z will be used instead
of H, V and D. These text boxesmay be labeled X, Y or Z if the current coordinate system aligns
with one of the primary planes. Dialog boxes use the appropriate letters. Regardless, the values
always appear in the same order in the dialog boxes, horizontal, vertical and then depth.

CS Grid and Axis Marker
The coordinate system (CS) grid and Axismarkers are very important tools when working with
multiple coordinate systems. The CS grid graphically displays the planar orientation of the current
coordinate system. The CS grid and Axismarkers will be drawn on the screen when the CS Grid
button in the Floating Toolbar is selected.When creatingmultiple coordinate systems, the CS grid
should be displayed on the screen at all times.

The CS Axismarkers will be placed at the origin of the current coordinate system. The Axismarker
arrows show the positive direction of the horizontal (H) and vertical (V) axes.

At the intersection of the Axismarker arrows, there is either a plus “+” or minus “–” sign. This
indicates the polarity (positive/negative direction) of the Depth (D) Axis with respect to the current
view.

When the horizontal and vertical axes align with one of the primary axes, the system labels the Axis
markers with X, Y and Z. This is the case with three of the four coordinate systems used with
Mill/Turn parts, the ZX plane, the XY plane and the YZ plane. The other CS is labeled with HY
because the X Axis is flipped in the opposite direction.

The grid is drawn in dark gray and shows the plane of the current coordinate system. Additional
light gray lineswill be drawn showing where the coordinate system intersects with the workspace
stock.
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1 2 3 4

1. ZX Plane
CS1

2. XY Plane
CS2

3. HY Plane
CS3

4. YZ Plane
CS4

Axismarkers for the four Mill/Turn planes (ZX, XY, HY and YZ).

Graphics Preference

TheGraphics Preference which is
accessed from the
File>Preferences>Display option,
contains an item called Grid
Brightness. This affects the
contrast and brightness of the CS grid drawn on the screen. The brightness can be adjusted by
moving the slider. Clicking on the Apply button in the Graphics Preference dialog will apply the
changes.

CS List
Coordinate System button
This button will access the CS list menu and the CS list. If Advanced CS is not available this button
is only active when a C Axismachine is defined.

CS List menu
Click and hold the CS button to open the CS list menu which
displays the four coordinate systems contained in theMill/Turn part
file.

CS List
Depress the CS button to open the CS list. This dialog displays a list
of all existing coordinate systems, highlighting the current
coordinate system. It is strongly recommended that the CS list
remain on the screen at all timeswhen working with multiple
coordinate systems.

Each CS has an eye icon next to it. Double-click the eye of a CS
tomake it visible or invisible. When open, the CS Frame Indicator
for that coordinate systemwill be displayed on the screen. This
action does not affect the current CS, which will remain highlighted
in the CS list. The CS grid and Axismarkers will be based on the
current CS.
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1. Visible Indicator
2. Hidden Indicator

CS Frame Indicator
The system can also display a CS frame indicator that shows the origin of another CS. CS frame
Indicators aremade up of three red lines that display the unlabeled three axes that make up the CS.
Click the red lines to quickly switch from one CS to another. Double-click the eye icon in the CS
list to show and hide a CS frame indicator. Ctrl-click to select/deselect multiple eye icons.
Shift-click to select a contiguous group. Close the CS list to quickly deselect all eyes.

1. Indicator for XY Plane

Menu Items
The followingmenu items are only useful when working with multiple coordinate systems.

Edit Menu
Select Current CS:
This item is found in the Edit > Select Special submenu.When this item is selected all geometry in the
current coordinate system contained in the current workgroup will become selected. Geometry and
bodies in other coordinate systems or workgroupswill not be selected.
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View Menu
Home view:
This item is also available as a button on the View palette. When selected, the system rotates the
view of the part to a view normal (3D perpendicular) to the current coordinate system. The Home
view always displays the part with the positive Depth Axis projecting out of the screen. This has the
effect of showing the part rotated into the position it will be in when it ismachined.
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Modify Menu
The Change CS (XYZ) and Change CS (HVD) items are only
available if geometry is selected. Either itemwill reassign
geometry to the current CS.

Change CS (XYZ)
When Change CS (XYZ) is used, all selected geometry will be
assigned to the current coordinate system. The geometry will
stay in its same location in 3D space. It will change color to
reflect the fact that it is now in the current coordinate system.
All selected arcs will be segmented (changed into line
segments), if the coordinate system they are being changed
into uses a different plane than their original coordinate
system.

Change CS (HVD)
When Change CS (HVD) is used, all selected geometry will be
assigned to the current coordinate system, and the HVD values of the geometry will be preserved.
Thismeans that the geometry will bemodified to be planar to the new CS location preserving the
relative position.

Terminology
Live Tool
When a live tool is used, the Turning spindle stops rotating and engagesC Axis rotarymotion. A
milling tool is set to spin at a specified RPM.

Wrapped Geometry
A standard term for geometry that is drawn flat and wrapped or rotated around.

The terms coordinate system, plane, and CS are
used interchangeably throughout this guide.

Comparison Summary
Mill/Turn allows you to use a livemill tool with simple angle positions of the C-axis on theOD or face
of the part. Polar & Cylindrical Milling allows you to wrap geometry about the C-axis and allows
continuousC-axis rotation when programmingmilling operations. If themachine has Y-axis
capabilities anymill operationmay be performed at anyC-axis position.
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1 2

1. Turning
2. Mill/Turn

3 4

3. Polar & Cylindrical
Milling

4. Mill/Turn with Y-axis
capability

A comparison of capabilities in systemmodules.



Part Setup

13

Part Setup
• Machine Definition Documents on page 13

• Mill/Turn Coordinate Systems on page 13

• Geometry Creation on page 16

• Tool Orientation on page 17

Machine Definition Documents
Setting up a C Axis part is very similar to that of a standard turning part. The stock is designated in
the samemanner and the options for designating clearance planes are identical to that for turning
parts.

Radius/Diameter
The X dimensions style (radius/diameter) selection only applies to geometry and clearance values in
the ZX plane. The dimensions are designated Xr or Xd depending on the choicemade in the stock
setup. Turning operations can only be created in the ZX plane. Milling and other CS planeswill
always use the diameter Xr style.

Mill/Turn Coordinate Systems
C-Axis Turning parts create four standard coordinate systems automatically. These assist in
creating geometry andmachining operations on different areas of the part. The standard turning ZX
plane is used for turning operations. The XY plane is used for facemachining. The HY backside plane
is used for machining the back face. The YZ plane is used for OD milling operations. These four
coordinate systems cannot bemodified.

Advanced CS allows you to create andmodify user coordinate systems into any planar
orientation and program positioningmoves for milling operations. For Mill/Turn, the Advanced
CS option allows additional coordinate systems in any orientation and createmilling operations that
use the non-standard coordinate systems for themachining CS.
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Operations and Coordinate Systems

Turning Operations

In a turning operation, the designation of themachining coordinate system is set by the selection
made in the process dialog for OD, ID or front face. The approach type selection designates the
axis along which the tool will approach and cut the part. The standard turning CS is CS1: ZX plane.
Turning operations also require the tool orientation to be specified, but this does not determine the
machining CS. It is very important to designate the appropriate orientation in order to achieve the
correct toolpath.

Milling Operations

For milling operations, the proper CS must be set by the user through the process dialog.

Themachining CS is used to determine how the tool will approach the part. In milling operations the
tool orientation typically designates the axis of tool approach.

Approach Types and CS Use in Mill/Turn
The following pages illustrate the proper use of Coordinate Systemswithin a standardMill/Turn
part.

Standard Turning CS



Operations and Coordinate Systems

15

Standard OD Milling CS

Milling can include Y and C Axismoves.

Standard Front Face Milling CS

This CS would require a front face tool orientation as shown.
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Standard Back Face Milling CS

Note the vertical and Horizontal Axismarkers at the origin compared to the Front Face CS in the
previous image. In this view of the front face XY plane, which represents the front face has a “+” sign
at the intersection of themarkers indicating that the positive direction of the depth Axis is projecting
outward. Switching to the Back face plane (labeled asHY) has a “–” sign on the Axismarkers,
indicating that the view is from the –D Axis. The +D Axis projects out from the backside of the part.
Essentially the difference between the XY plane and the HY backside plane involves the depth axis
along which the tool will approach the part.

Whenmachining either the front face or the back face, the tool must approach the
part from the positive Z axis of the CS. This is the reason that two coordinate systems
are created to facilitate facemachining.

Geometry Creation
Geometry CS contrasted to Machining CS. Geometry can be created in any coordinate system.
The CS to which the geometry is assigned has no bearing on themachining CS. Typically, the
machining CS is designated by the CS selected in the process dialog. If geometry is not created in
the appropriate CS for the type of operation that is being created, it is very likely that the resulting
toolpath will not produce the desired results. The toolpath will be created based on themachining
CS, regardless of the CS of the geometry. Geometry will bemachined as it is viewed from the
machining CS.

Which CS for geometry? Geometry should be created in the appropriate coordinate system for the
type of machining operation to be created. Geometry that defines the cut shape for OD machining
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operations should be created in the YZ plane. Likewise, geometry for front face operations should
be created in the XY plane and geometry for back face operations should be created in the HY
backside plane.When creating geometry to bemachined on the back face, it may be helpful to force
the depth of the geometry so that when viewed on the screen, it appears in the correct location. This
is recommended for visualization purposes only, as themachining operation and depths of cut will
be calculated from the information entered in themachining process dialogs, not the location of the
selected geometry.

All geometry for OD milling operationsmust be created in the YZ plane. Geometry is created in a
position as if it were to bemachined in the C0 position. The rotation is accomplished when the
toolpath is created by entering an angle value in themachining process dialog. The position C0 is
along the positive direction of the X axis in the standard YZ plane. The system allows the user to
designate a start angle when positioning the C axis. All geometry for OD operationsmust be
created in the standard YZ plane, regardless of the start angle. As a result, often times geometry
will not be created in the exact planar location in which it will bemachined. For example, if a flat slot
is created on theOD to bemachined at a start angle C90, the geometry would be created at C0 and
when the toolpath is created it will be rotated into position.

Wrapping. Geometry can also be created and viewed radially or wrapped when the Polar &
Cylindrical Milling option is installed. For more information, see the extensive discussion in
“Mill/Turn with Polar & Cylindrical Milling” on page 23.

Tool Orientation
The orientation of amill tool is a very important aspect in properly setting up a tool. By default, all
tools are oriented to themain or primary spindle. That means that the tool orientation in the tool
dialog should be set to match the tool’s actual position when looking at the spindles from the front of
your machine.

Milling tools are slightly easier to set up than turning tools because there are fewer variations. There
are only four positions — two each for horizontal and vertical. For machineswith B-axis support, the
tool may be used in a range of orientations, and this is controlled by theMachining CS setting found in
Process dialogs. Please note that the orientation specified is when the B-axis is zero.

Approach towards the face of the
main spindle.

Approach away from the face of themain spindle or
back sidemilling.

Approach from the +X side. Approach from the –X side.



Operations and Coordinate Systems

18

Tool Orientation Diagram
Setting the proper tool orientation is very important as it determines the axis along which the tool will
approach andmachine the part. There are two basic axes along which the tool will travel, the X
axis, for OD operations, and the Z axis for face operations. To select the tool orientation, click one of
the four positions on the diagram so that it becomes highlighted.

If the tool orientation is not set correctly, the toolpath that will be generated will not produce the
desired results. Often times, the systemwill not be able to create a toolpath if the tool orientation is
not set correctly. Always check the tool orientation diagram if the toolpath (or lack thereof) does not
seem correct.

The image labels the tool orientation diagram according to the approach axis of the selection and
also what section of the part should be cut given the selection. It should be noted that a tool
approaching along the X axis, while typically used for OD work can also be applied tomilling
operations cutting the face.

1. Z Axis Approach (Front Face)
2. X-axis Approach (OD)
3. Z-axis Approach (Back Face)
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TOOL SETUP DATA
The Tool creation dialog contains a Tool Setup button. This allows you to add Toolblocks created
within Intermediate Tooling, to a Tool and its Toolholder. The Toolblock and the Toolholder can be
fully visualized to double-check orientation.
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Machining
• “Processes ” on page 20

• “Y Axis Interpolation and C Axis Interpolation” on page 21

Processes
When one of theMill/TurnMDDs is selected, themachining palette can be used to createmilling
and turning operations. The processes have the same functionality as standardmill and turning
parts. For detailed information on the processes, refer to theMill and Turningmanuals.

Milling Rotate Tab
When theMDD has a rotating axis, milling Process dialogs
have a Rotate tab. The Rotate tab lets you designate C-axis
rotation for the operation. The Rotate tab in milling
processes contains two selections for rotating the part:
Position and Polar & Cylindrical Milling. The Polar & Cylindrical
Milling selection is available only if the Polar & Cylindrical
Milling option is purchased.

Position
Position lets you enter an angle of rotation for the C Axis,
which designates the position in which the toolpath will be created.When the toolpath is generated,
the systemwill display it in the proper location based on the angle value entered. It is independent of
the geometry selected. Geometry created for face operations should be based on the XY plane and
geometry for OD operations should be created in the YZ plane. All geometry for OD operations is
created in the YZ plane in the C0 position. The position rotation is accomplished when the toolpath
is created. The posted code will contain the appropriate C Axis positioningmoves.

Duplicate allows for subroutine repeats at equal angular intervals of the toolpath generated by the
operation. The systemwill create the toolpath dictated by the Position information and duplicate
that toolpath a specified number of times at the interval angle position entered in the C text box. The
value entered in the times text box is the additional number of times the toolpath will be repeated.
For example, if you are creating a toolpath using Position at a specified C angle, the processwill
create the toolpath at that angle and then duplicate it the given number of times at the given angle
intervals. Thus the Duplicate # is the total number of subroutines the operation is to be performed
minus one for the original step.

The C rotations position corresponds to the positive direction of the X Axis and proceed in a
clockwise direction. Negative values are valid for start angle positions. For example, a value of -45
could be used, which is identical to entering 315. The value entered for the start position should be
in anglemeasured in degrees.
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Y Axis Interpolation and C Axis Interpolation
The Y axis allowsmovement which is perpendicular to the rotation of the part. For instance, a Face
Milling processwithout a Y axis would require the part to rotate to cut a flat surfaces. This is called
C-axis interpolation. The rotation of the C axis will be used to achieve anymovements needed in Y.
To achieve this, be sure to select Polar & Cylindrical Milling in the Process dialog.

1. OD Milling
2. Y Axis

A Y-axis toolpath cannot be wrapped. If Position is selected in the Rotate tab, only Y-axismoves are
created. In other words, Y-axismoves are not generated when creating a wrapped or Polar &
Cylindrical Milling toolpath. When Polar & Cylindrical Milling is being used, all movements are
converted to C-axis interpolation.

The image shown to the right illustrates some of the differences in Y-axis and C-axisOD moves of
the same process. The top set of images comes from amachine that does not have Y-axis
capabilities,; the second set from amachine that does support Y axis.

A Y-axis-capablemachine can produce this samemovement as
the C-axis interpolation by selecting Polar & Cylindrical Milling in the
Rotate tab.

The image below illustrates a facemilling contour would use interpolation with C-axis and Y-axis
moves. The last image in each set shows the tool as an overlay to demonstrate all movement.
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A facemilling contour with C-axis and Y-axismoves
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Mill/Turn with Polar & Cylindrical
Milling

If Polar & Cylindrical Milling is available, it allowsC-axis rotation in milling operations. This is often
referred to aswrapping. This section describes functions that are specific to Mill/Turn when the
Polar & Cylindrical Milling option is installed. This section assumes a familiarity with the standard
Polar & Cylindrical Milling functionality described in theMill guide.

C Axis Interpolation for Polar and Cylindrical
Milling
The Polar & Cylindrical Milling option enableswrapped geometry and toolpath about the C axis by
rotary interpolation of the C axis in milling operations.

Rotate Tab
The Rotate tab for rotarymilling processes contains
two rotation options: Position, and Polar & Cylindrical
Milling. The operation can either be programmed
as a simple positionmove (Position) or as a
wrapped toolpath which will have continuousC
Axismotion (Polar & Cylindrical Milling). The
Position option is described in “Milling Rotate Tab”
on page 20.

Radial Geometry
Mill/Turn wrapped geometry is designated above
the standard YZ planeCS using a C-axis value for the angle of rotation. Geometry does not need to
be wrapped in order to bemachined using the Polar & Cylindrical Milling function. The toolpath that
results with the Polar & Cylindrical Milling option checked will be the samewhether the geometry
selected for the cut shape is flat or wrapped.

Defining a Rotary WG
To put aWorkgroup into radial mode, two interface itemsmust be selected. First: In theWorkgroup
Info dialog, theWrapped checkboxmust be selected. Second: In the floating toolbar, theWrap

WGs button must be selected.
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When you work in radial mode, geometry
dialogs that require coordinate input will contain
specifications for a C value, which is the angle
of rotation and a radius value. For example, with point creation using coordinates, the dialog will not
be labeled with Y, Z, and Xr, but rather C, Z, and R.

1. Designated as
“Position” in the
process dialog.

2. Designated as “Polar
& Cylindrical Milling” in
the process dialog.

Geometry and toolpath variationswithWrapGeometry button active
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Conventions
GibbsCAMdocumentation uses two special fonts to represent screen text and keystrokes or
mouse actions. Other conventions in text and graphics are used to allow quick skimming, to
suppress irrelevancy, or to indicate links.

Text

Screen text.  Text with this appearance indicates text that appears in GibbsCAMor on your monitor.
Typically this is a button or text for a dialog.

Keystroke/Mouse.  Text with this appearance indicates a keystroke or mouse action, such as
Ctrl+C or right-click.

Code.  Text with this appearance indicates computer code, such as lines in amacro or a block of
G-code.

Graphics

Some graphics are altered so as to de-emphasize irrelevant information. A “torn” edge signifies an
intentional omission. Portions of a graphicmight be blurred or dimmed to highlight the item being
discussed. For example:

Annotations on a graphic are usually numbered callouts (as seen above), and sometimes include
green circles, arrows, or tie-lines to focus attention on a particular portion of the graphic.

Faint green borders that outline areaswithin a graphic usually signify an imagemap. In online help
or a PDF viewer, you can click a green-bordered area to follow the link.
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Links to Online Resources

Link URL Action / Description

Go http://www.GibbsCAM.com Opens themain website for GibbsCAM.

Go https://online.gibbscam.com

Opens a restricted website containingmaterials
available for download. Requires aGibbsCAM
Online Services account; to set up an account,
contact GibbsCAM Support.

Go https://store.GibbsCAM.com
Opens the website for the GibbsCAM Student
Store.

Go https://macros.gibbscam.com
Opens a wiki containing documentation and
examples of GibbsCAMmacros. Requires a
GibbsCAM account.

Go http://kb01.GibbsCAM.com

Opens a Knowledge Base article, Contour
Operations Using Thread Mill Tools, that
explains in detail the correct way to program
Contour processes using ThreadMill tools.

Go mailto:Support@gibbscam.com
Runs your email client to create a new message
addressed to the CAMBRIO Technical Support
department for GibbsCAM.

Go mailto:Registration@gibbscam.com
Runs your email client to create a new message
addressed to the CAMBRIORegistration
department for GibbsCAM.

Go mailto:Sales@gibbscam.com
Runs your email client to create a new message
addressed to the CAMBRIO Sales department
for GibbsCAM.

Go http://www.autodesk.com/inventor
Opens an external website that provides more
information on Autodesk Inventor products.

Go http://www.celeritive.com
Opens an external website that provides more
information on VoluMill Ultra High-Performance
Toolpath (UHPT) from Celeritive Technologies.

Go http://www.predator-software.com
Opens an external website that provides more
information on a CNC editor and a virtual CNC
viewer from Predator Software, Inc.

http://www.gibbscam.com/
https://online.gibbscam.com/
http://store.gibbscam.com/
https://macros.gibbscam.com/
http://kb01.gibbscam.com/
mailto:Support@gibbscam.com
mailto:Registration@gibbscam.com
mailto:Sales@gibbscam.com
http://www.autodesk.com/inventor
http://www.celeritive.com/
http://www.predator-software.com/
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